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 یفرد صحیحاب با جواه همرت لااسو

  و میباشند نیکیولکترا يگیردیا سیستم یک ناپذیر ییاجد يها قسمت...................

 .می شوندد یجاا              نیکی هستند که توسطولکتري اگیردیک برنامه یااز خصوصیاتی 

مؤلفه ها  -یژگیها و -مؤلفهها 

یژگیها و –مؤلفه ها  -یژگیها و

 هااربزا یژگیهاو - مؤلفهها

 هااربزا –مؤلفه ها  - یژگیهاو
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LCM.به چه معناست 

 سیستميگیردمدیریتیا

 يگیردیااي مدیریت محتو سیستم 

 يگیردیااي تولید محتو يهااربزا

 مانیزسا يهاارفزا منر مدیریت سیستم
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ستا ارفزا                                         منر   MEmuیک 

 زيمجا ماشین یا زسا شبیه

ا محتو تولید

 زيمجا زشموآ

 ردمو سه هر
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 ؟کنند می دیجاا را نیکیولکترا يگیردیا یژگیو امکد ها برلینکا

 رختیاا در لکنتر و تعاملی ،بررکا سهولت

ر عتباو اتعاملی ، بررگیر سهولت کاافر

 و تعاملی ،بررکا سهولتستی و در

 تخصص گانگیچند

 نهراهمکا يگیردیا و تعاملی ،بررکا سهولت
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  ستا......شیابیارز شامل انگیرافر در یابیارز

 ،ینزغاآکمی اترو  تکوینی

 کمیاتروتکوینی 

 کمیاترو تشخیصی ، تکوینی ،ینزغاآ
 

 ،ینزغاآ ،تکوینی ،تشخیصی کمیاتر و يتأیید

 .ستا                                                   رنیکی متمرکز بولکتري اگیردیادر یابی ارز

 تمحصولا و یندآفر د،فر

 

 امحتو و گیرنددیا

 نهندگاددیاو  نگیرندگادیا
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 .ستا      .......             نیکی متمرکز برولکتري اگیردیادر یابی ارز

 تمحصولا و یندآفر د،فر

 

 اومحت و دفرن گیرندگادیا

 نهندگاددیاو  نگیرندگادیا
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 دامو يرادهگن و هئارا ،هعسوت ،                     ي،زیر همرناب یگنوگچ هب یکینورتکلا يرگیدای یابیزار

نظر ، شیزموت آکیفیت خدماان میز، هادوره پشتیبانی و     ،تلفیقیو نیکی ولکتري اگیردیا

 .دارد توجه سیدر مطالب از انگیرافر يرگیدیا انمیز و برنامه به نسبتنینفعاذ

ه نحوو  حیاطر تولیدو  حیاطر

 یسرتد هنحو و تولیدیس رتد

 یابیو ارز حیاطر
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 :دکر رهشاا یرز اردمو به انتو می دشا برنامه مخاطبین بخش تمکاناا جمله از

 مخاطب يجستجو و مخاطب دنکر ضافها و فحذ

 مپیا لساار و ستما ن،مخاطبا هشد مرتب لیست همشاهد

 صلیا صفحه به ودنفزا و دنکر ودمسد ارش،گز

 ردسه مو هر
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 ؟هست بهتر یرز روش امکد با دشا برنامه ايجرا تمکاناا و يبصر ظلحا از

 

 با اجراهوشمند  گوشی روي بر پلیکیشنا ايجرا رتصو به

 هوشمند گوشی روي بر وب تحت نسخه از دهستفاا

 پتا لپ و کامپیوتر در یدروندا زسا شبیه یا زيمجا ماشین از دهستفاا
 

 تبلتروي پلیکیشن بر ا ايجرا
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 دجوو جدید هستگاد یک در ورود منیتا ضریب دنبر بالا نمکاا مرحله چند تا منیتیا نظر از

 دارد؟

1 

2 

3 

4 
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 .ستا ... دجوو وهگر در مپیا لساار منا به اي گزینه دجوو فلسفه ترین صلیا

 امحتو دلتبا

 تعامل

ط تباار

 راتختیاا
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 امکد دشا در ها فایل هخیرذ محل ترین صلیا

 ؟ستا

 My Files > Device storage > Shad
My Files > Device storage > Download 

My Files > SD card > Shad 

My Files > SD card > Download 
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 د؟شو می حمطر نیاعنو چه تحت نیکیولکترا زشموآ در هارکا حجم یشافزا

 

 سکلا ازهندا

 ريکاربا      

 مالکیت حق 

 کارمجازي
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 ؟هست کسانی چه رختیاا در سهرمد لکانا به عضو ودنفزا

 لکانا مدیر

 ان بیرد

 نینومعا

 زانموآ نشدا 
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 ؟هیدد منجاا باید را ريکا چه د،شو فحذ وهگر يعضاا همه ايبر مپیا هیدابخو گرا

 

 وهگر يعضاا همه بنتخاا

 

 وهگر کل بنتخاا

 

 ءعضاا همه ايبر فحذ گزینه زدن تیک

 

 ءعضاا همه فحذ زدن تیک
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 را رکا ینا قسمت امکد در ،نمایید هخیرذ دشا برنامه در را تصویر یک یا و متن یک هیدابخو گرا

 ؟ هیدم دنجااباید

 یروتصا هخیرذ

 دهشه خیري ذها ماپی

 يگالردر  هخیرذ 

 هشد لساار يها مپیا
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 دارد؟ دجوو دشا برنامه در اردمو امکد هخیرذ نمکاا

 

نیمیشن ا و فیلم ،تصویر ت،صو ،متن

نیمیشن ا و فیلم ،تصویر ت،صو

 فیلم و تصویر ت،صو ،متن

 نیمیشنا و فیلم ،تصویر ،متن
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 د دارد؟جوروش و امکد سه بارمدل کانادر عضویت ن مکاا

 للینک کانا

 لمدیر کانا ودنفزا

 دشا توسط رکادخو عضویت

 

 اردمو همه

19 

 دارد؟ دجوو دشا به یگرد يها نسار مپیا از مستقیم رطو به سانهر امکد دنکر کپی نمکاا

 فایل متنی

 

 

 متن

 عکس 

 فیلم
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 دارد؟ دجوو دشا در ردمو امکد رکادخو دنلودا دنکر ودمسد نمکاا

 

خصوصی ي گفتگو یروتصا

 هیوگري گفتگو یروتصا

 ها لکانا یروتصا
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 ردسه مو هر

 دارد؟ ريگازسا دیکررو امکد با ريساختا نظر از بیشتر دشا برنامه طریق از زشموآ

 

 یی اگررفتار دیکررو

 ییاگر شناخت دیکررو

 ییاگر هندزسا دیکررو

 ییاگر طتباار دیکررو
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 ؟ستا پذیر نمکاا تیرصو چه در وهگر یا لکانا مالکیت لنتقاا

باشد  شتهدا مدیر یک قلاحد وهگر یا لکانا

 باشد شتهدا مدیر دو قلاحد وهگر یا لکانا

 باشد شتهدا مدیر سه قلاحد وهگر یا لکانا

 باشد شتهدا مدیر ونبد وهگر یا لکانا
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 ؟ستا همیتا حائز نظر چه از مپیا متن ازهندا

 

 يهنر

 شناختی یباییز

 اري یدد

 مپیا تأکید
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 ؟چیست دشا برنامه صلیا صفحه به ورود از پس مگا لیناو

 مخاطبین ودنفزا

 سکلا ودنفزا
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 سنجی صحت

 ورودمز ر تأیید

 ؟ستا امکد نیکیولکترا يگیردیا مؤلفه لیناو

 شیزموآحی اطر

 اي سانهر چند مؤلفه

 ینترنتا اربزا

 

 زسا هخیرذ يها سیلهو و کامپیوترها
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 دجوو وب تحت دشا به وزیندو تحت يها نسار مپیا از فایل لساار نمکاا یاآ

 دارد؟

 نیست پذیر نمکاا يچیز چنین خیر

 اردند دجوو دشا در نمکاا ینا فعلا خیر 

 دشو می ممکن رینکاا د،شا در آن دپلوآ و وزیندو دشا پوشه در آن هخیرذ و دنلودا با بله
 

 

 داد ارقر را فایل دشو می دنکر کپی با بله
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 دارد؟ دجوو گوشی یک در دشا برنامه از بررکا دو دهستفاا نمکاا یاآ

 

 ستا پذیر نمکاا نکلو يها برنامه باارد ند جوو مکانیا همچین جهو هیچ به

 دارد نمکاا صخا يها گوشی از يسر یک در فقط
 

 نیست صخا برنامه به زينیا و بله
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 دارد؟ دجوو دشا در ديفر با طتباار نمکاا تلفن رهشما شتندا ونبد یاآ

 

 شخص ملی کد با بلهي بررکام بله با ناخیر 

 هنشد بینی پیش دشا در لیو دارد نمکاا
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 دارد؟ دجوو هشد یتاهد مپیا لینک طریق از طتباار نمکاا دشا در یاآ

 فقط باشند بله شتهدا سترسید دفر يبررکا بحسا به هشد یتاهد مپیا لینک طریق از ننداتو می ههم بله

 باشند شتهدا سترسید دفر يبررکا بحسا به هشد یتاهد مپیا لینک طریق از ننداتو می مخاطبین

 شتهدا سترسید دفر يبررکا بحسا به طریق ینا از ننداتو می کسی چه که ستا بررکا رختیاا در آن تتنظیما ماا بله

 باشد

 

 باشد شتهدا سترسید دفر يبررکا بحسا به هشد یتاهد مپیا لینک طریق از ننداتو نمی کس هیچ خیر
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ي گیردیاي فعالیت ها در تعامل .................  ايند براست که می تواتباطی ار         یمیلا

 .دگیر ارقر دهستفاا ردمو نگیرندگادیاتوسط

مؤلفه  - مؤلفه مؤلفه - ژگییو

 یژگیو-  یژگیو

 یژگیو -  مؤلفه
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 بطرا حیاطر یژگیو امکد به طمربو د،نشو عشباا طنامربو تطلاعاا با انبررکا هنذ ینکها

  ؟ستايبررکا

 ترتیبو  نظم

 يپذیر تفکیک

 رختصاا
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 ريگازسا

نیکی ولکتري اگیردبرنامه یایکدر ند ایمیل می توا،                   مناسبي هايتژاسترابا 

 .کند دیجاا نمعلما و نگیرندگادیابین          یژگیوتا یک د شوه گنجاند

 شیزموآحی اطر - تعاملی

 تعاملی - تعامل

 تعاملی - شیزموآحی اطر 

 تباطیار -  شیزموآ حیاطر 
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 ... پوشه در و دشو می وعشر آن دنلودا ،فایل منا رکنا پایین به رو فلش روي بر کلیک با

  .شدهداخوهخیرذ

 دانلوي ویندوز

 یدروندا دشا

 کامپیوتر دسناا

 کامپیوتر هخیرذ
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 هخیر کجا در باید فایل ضفر پیش رطو به ز،سا شبیه طریق از دشا در فایل دپلوآ ايبر

 ؟شوند

 Download > Memo Download

Desktop > Memo Download 

Download > Memo Desktop 

Download > Memo Document 

 35 

 د؟کر کلیک باید علامت امکد روي لکانا یا وهگر در فایل دپلوآ ايبر

 

 ل ساار

 یا پیوست قسنجا

 دپلوو آ دنلودا

 36 
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 ؟ستا هشد حمطر ستیدر به ردمو امکد پتا لپ یا کامپیوتر در دشا برنامه ايجرا 

 

 ز سا شبیه و وب تحت نسخه از دهستفاا

 وزیندو عامل سیستم و وب تحت نسخه از دهستفاا

 لمبد يها ارفزا منر و زسا شبیه از دهستفاا 10

 لمبد يهاارفزا منر و 10 وزیندو عامل سیستم از دهستفاا
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 ؟ستا وريضر یرز يها گیدماآ از یک امکد نیکیولکترا يگیردیا ايجرا ايبر

 

  یرساختز گیدماآ

 فرهنگی  گیدماآ

 ییامحتو گیدماآ

 اردمو همه
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 ...هک تسا ینا اه هار زا یکی ،داش هب ناسر ماپی یک زا لیاف لاسرا يابر

 ، )اريگذ اكشتراshare( روي کلیک ،نقطه سه روي کلیک ،فایل دنلودا ن،سار مپیا به ورود 

 باشه روي کلیک س،کلا روي کلیک د،شابنتخاا

 روي کلیک س،کلا روي کلیک د،شا بنتخاا ،نقطه سه روي کلیک ،فایل دنلودا ن،سار مپیا به ورود

  باشه

 ،)اريگذ اكشترا(share روي کلیک ،نقطه سه روي کلیک ،فایل دنلودا ن،سار مپیا به ورود

 باشهروي کلیک س، کلا رويکلیک

 د،شا بنتخاا ،)اريگذ اكشتراshare( روي کلیک ،نقطه سه روي کلیک ن،سار مپیا به ورود
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 ستدر را مسیر گزینه امکدوم،کر مثل يگرورمر در ها فایل هخیرذ محل تنظیم ايبر

؟ستادهکر حمطر  

Settings> Downloads> Location> 
Change  

Settings > Advanced> Downloads> Location> 
Folder Settings> Advanced> Downloads> Change 

Change Settings> Advanced> Downloads> Location> 
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 ،اه فایل ،ها سانهر مثل هشد يبند طبقه رتصو به ها فایل به سترسید ايبر

 د؟کر جعهامر باید فایلوپر در قسمت امکد به هغیر و ها هنگآ

سانه ر تتنظیما

 کیاشتري اها فایل

 فایل ها تنظیم

 سانه هار اكشترا
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 ؟باشد باید چگونه تتنظیما ها سانهر لساار و یافتدر جهت حافظه به دشا سترسید ايبر

permissions > Storage > ON 

permissions > Location> ON 

Storage > Storage > ON 

Storage > Location> ON 
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 باشهروي کلیک س، کلا رويکلیک

 ؟ستا بهتر برنامه امکد نصب ي،یدروندا گوشی یک از بررکا دو دهستفاا ايبر

Clone app 

MEmu 

AZ Screen Recorder 

Chatzy app 
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 دشو اجرا یرز ارفزا سخت امکد در ستا بهتر يبصر ظلحا از دشا برنامه

 دهوشميهاگوشی

 پلپ تاو  کامپیوتر 

 ها تبلت

 مچی هوشمند ساعت
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 ؟ستا یرز ردمو امکد شگاهیزموآ سطح در دور راه از زشموآ دبررکا عامل گترینربز

 

نیکی ولکترا يها زشموآ يگیرربکا

 شیزموي آعقب ماندگی هاان جبر

 شیزموآ يها هشیو در عتنو دیجاا

 ها اي سانهر چند از دهگستر دهستفاا
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 ،سترسیدرد تسریع ايبرزيیا ماشین مجاز شبیه سادر فایل ها                  هخیرذست محل ابهتر 

 .دشو تعیین تیسد رتصو به

 دپلوو آ دنلودا

 دنلودا

 پوشهد پلوآ
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 ؟ستا شکلی چه به MEmu زسا شبیه برنامه نمایش حالت بهترین

Tablet 

Phone 

Maximize 
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Customize 

 دارد؟ تیوتفا چه مخاطب فحذ با یخچهرتا دنکر كپا

 

 .ماند می یباق مخاطب ماا فحذ گفتگوها کلیه یخچهرتا دنکر كپا در

 .ماند می باقی گفتگوها کلیه ماا فحذ مخاطب یخچهرتا دنکر كپا در

 .دشو می فحذ مخاطب هم و گفتگوها هم یخچهرتا دنکر كپا در

 .دشو می فحذ مخاطب نه و گفتگوها نه یخچهرتا دنکر كپا در
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 ؟هست ردمو امکد شامل نیکیولکترا يگیردیا لمد در نلاینآ پشتیبانی

 

 تیبانیپش

 پشتیبانی شیزموآ

 اي ورهمشا

 فنی پشتیبانی
 

 اردمو همه

 
 
 
 
 
 
 
 

49 

 د؟شو می لفعا قسمت امکد از ها مپیا نمایش پیش

 ها  نعلاا / خصوصی حریم / تتنظیما

 ها نعلاا / هااصد و هانعلاا / تتنظیما
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 هان علاا / يبررکات تنظیما / تنظیما

 نمایش پیش / هااصد و هانعلاا / تتنظیما
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 بخش چه شامل نیکیولکترا يگیردیا از جامع يتصویر نمایش ايبرP 3 رپیوستا

 ؟ستا هایی

 دنیآرف – لوصحم – دفر

  لمحصو – یندآفر - دفر 

 اهرازبا – هدروآرف – دفر

 هردوآرف -  هارازبا – دفر
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 ؟ستا پذیر نمکاا نسار مپیا امکد و دشا بین امحتو و تطلاعاا دلتبا

تا یا

 وشسر

 گپ

 

 ها نسار مپیا تمامی

 
 
 
 
 
 
 
 

52 

 ؟ستا چگونه شیزموآ حیاطر در افهدا تحلیل ترتیب

 عینی و اي مرحله ،کلی افهدا ئهارا

 ئهاي ارا مرحله و عینی ،کلی افهدا ئهارا 

 عینی و کلی اي، مرحله افهدا

 کلی و عینی اي، مرحله افهدا ئهارا

 
 
 
 
 
 

 
53 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟چیست نمعلما لکانا اب سهرمد لکانا صلیا وتتفا

 .ستا نمعلما ايبر فقط نمعلما لکانا و لیااو ايبر سهرمد لکانا

 .ستا نمعلما ايبر فقط نمعلما لکانا و زانموآ نشدا ايبر سهرمد لکانا

 .ستا نمعلما ايبر فقط نمعلما لکانا و زانموآ نشدا و لیااو ايبر سهرمد لکانا

 .نماید يگیر عضو که ستا دیرم رختیاا در نمعلما لکانا و سهرمد لکانا
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 تحت دشا وتتفا

 ؟چیستددرپلیکیشنشااباوب

  
 
 
 

 
 ندوت دارتفات کلیادر                 55

  

 

 
 

 دجوو وتتفا يبررکا بطرا و يبرونا مثل جزئی اردمو در

 دارد

 ستا وتمتفا هم با رکا روش و ماهیت

 

 ندارند باهم تیوتفا هیچ

 
 

 

 

  

 بجورچا در شگاهیزموآ مسائل از بخش امکد ءجز دشا شبکه در زانموآ نشدا بجذ و مان ثبت

 ؟ستا نیکیولکترا يگیردیا

 

 اداري رموا

 تحصیلیر موا 

 انگیرافر تخدما

 شیزموآ رموا

 
 
 
 
 
 
 
 
 

 
56 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 د؟ کر خالی را دشا پوشه يها فایل گاهی از هر باید اچر

  گوشی حافظه نشد پر از يجلوگیر ايبر

 ها فایل نشد كپا از يجلوگیر ايگوشی بر نشد سیویرو از يجلوگیر ايبر

 هادنلودا سرعت در تسریع ايبر

    
 
 
 
 
 
 
 

57 

 د؟کر دهستفاا هستگاد یک در دشا وب تحت نسخه از بررکا سه یا دو انتو می چگونه

 

 دشو وارد وتمتفا گرورمر یک با کس هر

 دکر نصب را گرورمر یک وتمتفا يها نسخه

 دکر دهستفاا زسا هشبی از
 

 اردند دجوو مشکل ینا فعر ايبر حلی راه حاضر لحا در

 
 
 
 
 
 
 
 

58 

 د؟شو می دهستفاا کامپیوتر یا گوشی چند در شما يبررکا بحسا از که شد متوجه انتو می چگونه

 منیتا بخش در لفعا يها هستگاد طریق از

ن کلوي هاارفزم انرده از ستفاا با

 نپشتیبا با ستما طریق از

 سهربا مدیر مدط تباارطریق  از

 
 
 
 
 
 
 

59 

 ؟نمایید ضافها وهگر صلیا صفحه به ستا بهتر را کسانی چه
 

60 

 

 سکلا يها هنمایند

 سکلا يها هنمایند و نینومعا ،مدیر مثل یمدار ها آن با روز لطو در ديیاز تتعاملا که اديفرا 

 سکلا هر برتر اتنفر

 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 

 نیست رکا ینا منجاا به تیورضر

 دارد؟ را مخاطب دنکر ودمسد رختیاا کامل رطو به کسی چه

 

 )وهگر هندزسا( معلم

 )وهگر به هشد ودهفزا( مدیر

 ) وهگر مدیر نقش با( زموآ نشدا

 وهگر یک يعضاا همه

 
 
 
 
 
 
 
 

61 

 ؟ستا کترراکا چند دشا در يبررکا منا ايبر کترهاراکا ادتعد قلاحد

7 

6 

5 

4 
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 ؟ستا چند مپیا متن هازندا تغییر منهدا

 

 15تا 25

 15تا 30

 12تا 25

 12تا30 
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 ؟ستا رچقد دشا برنامه در رکادخو دنلودا سرعت منهدا

 

مگابایت  30 تا صفر

مگابایت  40 صفرتا

 مگابایت 50 تا صفر
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 مگابایت 60 تا صفر

 

 می                    ملع ار یمآد ياهراتفر و اه یبوخ رب يراذگ شرزا و یـسررب شـندا

 .دنمان

 شناسی رفتار

 

 ق خلاا

 وريفنا در قخلاا

 فرهنگ

 
 
 
 
 
 
 
 

65 

 و              رهمربوطه با ستاوه گرس در بیر هر کلاد دپلیکیشن شادر ا

 . سته امشخص شد                رهستا با سهرمدیر مد

 يخاکستر – بیآ

 یبآ – يرستکخا

 بیآ – بیآ

 يرخاکست - يخاکستر

 
 
 
 
 
 
 
 
 

 
66 

 ،نیدکر کامل اي، گزینه چند ،نیدکررجو ،غلط-صحیح تلااسؤ اعنوا از ... يها نموآز در

 .دشو می دهستفاا ترسیمی و مسئله حل ،تشریحی،پاسخهکوتا

دي عملکر

 سنجی شنگر

 شناختی

 عاطفی سنجش
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 . دمی شوده ستفاامصاحبه ، پرسشنامهاز              يهان مودر آز

دي عملکر

 سنجی شنگر

 شناختی
 

 عاطفی سنجش

 
 
 
 
 
 
 
 

68 

 همشاهدر، پوشه کا، موقعیتید عملکروژه، پرزي، شبیه سار، نمونه کااز           يهان مودر آز

 . دشو می دهستفاا )رينگا قعهوا یا يبند جهدر سمقیا ،لیست چک( رفتار

 ديعملکر

 سنجی شنگر

 عاطفی سنجششناختی 
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 د؟شو می طمربو هشد ئهارا لمد از قسمت امکد به فایل هخیرذ بحث ،نیکیولکترا زشموآ رد

 

ئه ارا

تولید 

 لمحصو

 يرادهنگ

 
 
 
 
 
 
 
 

70 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 قسمت ینا يها گزینه ،هست ديعمو نقطه سه عضو هر ويبررو در وه،گر تتنظیما بخش در

 ؟منداکد

م پیا لساار و وهگر مدیر به ءتقاار

 فحذم یاپل ساوه و ارگر از فحذ

 مالکیتل نتقاوه و اگر از

 وهگر از فحذ و وهگر مدیر به ءتقاار

 
 
 
 
 
 
 

71 

 ارد؟ند نصب به زنیا دشا حالتی چه در

  وبتحت  حالت

ز سا شبیه در دهستفاا حالت

 اههمر گوشی از هدستفاا

 دارد نصب به زنیا اردمو تمامی در

 
 
 
 
 
 
 
 

72 

 ؟هست پذیر نمکاا یرز روش امکد با دشا برنامه ايجرا حاضر لحا در

هوشمند  گوشی در پلیکیشنا ايجرا رتصو به

 وب تحت نسخه از دهستفاا با اجرا

 مختلف يها عامل سیستم در یدروندا زسا شبیه یا زيمجا ماشین از دهستفاا

 

 ردسه مو هر
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 ؟ستا پذیر نمکاا یرز تطلاعاا امکد با زانموآ نشدا هویت ازحرا حاضر لحا در
 

74 

 
 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 گیادخانو منا و منا ،ملی کد

  یخ تولدرتاو ملی  کد

 شناسنامه لسریا و ملی کد

 تلفن رهشما و ملی کد

 

 د؟شو می داده نمایش کجا در عضاا ادتعد دشا وب تحت حالت در

 

 سکلام نار کنا در

وه مدیریت گرت تنظیما در 

 عضاا رششما طریق از

 يگیر ارشگز طریق از
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 گرورمر ................. نسخه از ستا بهتر کنید می دهستفاا دشا وب تحت نسخه از هک حالتی در

 .بکنید دهستفاا

قدیم 

 جدید

 هشد محافظت
 

 هشد اريخرید

 
 
 
 
 
 
 
 
 

 
76 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 يهااربزا با قعیوا موقعیت یک زيسا شبیه ايبر زموآ نشدا از ستاخو در

 ؟ستا یرز يها نموآز از یک امکد ءجز یجیتالید

 ديعملکري ها نموآز

 نموآزشناختی ي هان موآز

 سنجش عاطفیي ها

 نگرشیي ها نموآز

 
 
 
 
 
 
 
 
 

 
77 

 نکته کنید می دهستفاا دشا برنامه ايجرا ايبر کامپیوتر در یدروندا زسا شبیه از که مانیز در

 ؟تایپ متن چیستم هنگا يکلید

  
 

7 

 

 

 

اردنددجوو سیرفا متن تایپ نمکاا  

  تایپ متن فارسی حتم  اً یک بار در محل نوشتن متن کلیک کنید تا انگلیسی تایپ نشود زمان

 اردند نمکاا نباز تغییر
 

 کنید اجرا رهبادو و ببندید را برنامه ریکبا حتماً متن تایپ ايبر

 

 ؟ستا تر صحیح جمله امکد عضو ودنفزا به وهگر يعضاا سترسید مینهز در

 از عضاا تکمیل از بعد و زبا عضو ودنفزا ،سیکلا وهگر تشکیل لیهاو يهاروز در ستا بهتر 

 .دشو رجخاسسترد

 باشد عضاا سسترد در همیشه ستا بهتر
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

باشد  عضاا سسترد از رجخا همیشه ستا بهتر

 دارد سهرمد مدیر تصمیم به بستگی

؟ نیست صحیح جمله امکد وهگر يعضاا توسط مپیا لساار گزینه مینهز در

 باشد زبا گزینه ینا ستا بهتر تعامل و رفکاا دلتبا ايبر

 لساار ،ستا مهم ها فایل و ها مپیا تسلسل لیاتو و کنید می لساار مطلب يسر یک که مانیز در
  بسته باشد بایدمپیا
 باشد زبا مپیا لساار ستابهتر يفکر رشبا مثل هایی روش از دهستفاا رمنظو به

 باشد بسته میاپ لساار همیشه ستا بهتر نظمی بی از يجلوگیر جهت
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 رهسه با ستارمدیر مدو              رهمربوطه با ستاوه گرس در معلم هر کلاوب، تحت د شادر 

. ستا هشد   مشخص 

 بیآ- بیآ

 یبآ – يرتسکخا

 يخاکستر – بیآ

 يخاکستر - يخاکستر

 
 
 
 
 
 
 
 
 
 

81 

 .نمایندل سارم اپیادي حالت عادر نند اسه                 می تورمدل کانادر 
 

82 

 

 لکانا مدیر و سهرمد مدیر

زان موآنش و دامدیر 

 زانموآ نشدا و نمعلما

 ءلیااو و زانموا نشدا

 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟ستا رفتار در تغییر يگیردیا د،یکررو امکد در

 ییاگررفتادریکررو

یی اگر شناخت دیکررو

 ییاگر هندزسا دیکررو

 ییاگر طتباار دیکررو

 
 
 
 
 
 
 

83 

 ؟ستا نشدا شخصی يمعنا خلق يگیردیا د،یکررو امکد در

یی اگررفتار دیکررو

یی اگر شناخت دیکررو

 ییاگر هندزسا دیکررو

 ییاگرط تباار دیکررو

 
 
 
 
 
 
 

84 

 می جدید يها طتباار و ها هگر خلق یندآفر از ستا رتعبا يگیردیا د،یکررو امکد در

 ؟باشد

یی اگررفتار دیکررو

 ییاگر شناخت دیکررو

 ییاگر هندزسا دیکررو

 ییاگر طتباار دیکررو

 
 
 
 
 
 
 

85 

 ؟هیدد ئهارا را دخو از يمختصر حشر یا مهرزو نیداتو می فایلوپر تتنظیما قسمت امکد در

 حریم خصوصی تنظیم

 تنظیم منا تنظیم

 يبررکام نا

 فیابیوگر تنظیم

 
 
 
 
 
 
 

86 

 ؟ستا هشد اريگذربا فمختل يها پایه و ها شتهر کلیه به طمربو يها فایل و ها فیلم لکانا امکد در
 
 
 

87 
 

 ورشپرزش و مول آکانا
 

 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 شیزموآ ادمو و امحتو لکانا

 زانموآ نشدا لکانا

 سهرمد

 سهرمد نمعلما لکانا

 

 هشد اريگذربا مختلف يها پایه و ها شتهر کلیه به طمربو يها فایل و ها فیلم لکانا امکد در

 ؟ستا

 

 ورش پر و زشموآ لکانا

 شیزموآ ادمو و امحتو لکانا

زان موآنش دا لکانا 

 سهرمد

 سهرمدن معلمال کانا
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 ؟باشد زبا ها سانهر رکادخو دنلودا ستا بهتر ردمو امکد در

 کنیم دنلودا را یرومثلتصا خاصی يها سانهر یا ها سانهر متما یمدار قصد که هیوگر یا لکانا در ها وهگر در

 خصوصی يگفتگوها
 

 ها لکانا در دموجو متنی يها فایل
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 
 دارد؟ کلاسی وهگر در را وهگر مدیر ودنفزا رختیاا کسی چه لیهاو مگا در

 

 مدیر 

 معلم

 ونمعا 

 زموآ نشدا
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 دارد؟ کلاسی وهگر در را وهگر مدیر ودنفزا رختیاا کسی چه لیهاو مگا در

 

مدیر 

معلم 

 ونمعا

 زموآ نشدا

 
 
 
 
 
 
 
 

 
91 

 

 
 

 

 امکد ءجز یجیتالید يهااربزا با قعیوا موقعیت یک زيسا شبیه ايبر زموآ نشدا از ستاخودر

 ؟تسا ریز ياه نموزآازیک

  ديعملکري هان موآز 

 شناختی ي هان موآز

 سنجش عاطفیي ها نموآز

 نگرشیي ها نموآز
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 د؟کر دهستفاا انتو می ردمو امکد از دشا منیتا مینهدرز

 از دهستفاا رکادخو قفل

 پین از دهستفارواژه اگذ

 اردمو همه
 

 
 
 
 
 
 
 
 

93 

 ؟ستا امکد نیکیولکترا يگیردیا یندآفر دارنمو صلیا بخش دو

 اري نگهد و ئهارا

 تولید محتوي ویادگیري

 تولیدو  حیاطر

 یابیو ارز تولید

 
 
 
 
 
 
 

94 

 دارد؟ حالت چند رواژهگذ رساختا

 دعد فقط که واژه رگذ و ستا وفحر و دعد که پین 

 وفحر و دعد که واژه رگذ و ستا دعد فقط که ست پینه

 هست

 دعد فقط که واژه رگذ و ستا کترراکا و وفحر د،عد که پین

 هست

 

 هست کترراکا و وفحر د،عد که واژه رگذ و ستا دعد فقط که پین

 
 
 
 
 
 
 
 

95 

 ؟ستا امکد دشا در ها فایل هخیرذ راه ترین دهسا
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 پوشهدر  هخیرذ

 دانلودها ذخیره در

 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 برنامهدر  اجرا

  

 

 

 هخیرذپوشه ا در جرا
 

 دارد؟ مزیتی چه لکانا یا وهگر یا مخاطب دنکر قسنجا

هد د می ها لکانا به ترتیب و نظم

د شو می ها وهگر از لکانا تفکیک موجب

 هدد می مخاطبین به ترتیب و نظم

 .دشو می حتترار یمدار دیاز جعهامر که مخاطبی یا وهگر ل،کانا به سترسید

 
 
 
 
 
 
 
 

97 

 

 ؟ستا یرز يها نموآز از یک امکد ءجز اي گزینه چند يها السؤ

دي عملکري ها نموآز

 شناختیي هان موآز

سنجش ي ها نموآز

 عاطفی

 تیرمهاي ها نموآز
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 ؟ستا یرز يها نموآز از یک امکد ءجز ترسیمی و مسئله حل يها السؤ

شناختی ي ها نموآز

 تیرمها يهان موآز

 سنجش يها نموآز 

ي ها نموآزعاطفی 

 ديعملکر
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟ستا یرز يها نموآز از یک امکد ءجز تشریحی و پاسخ هکوتا يها السؤ

دي عملکري ها نموآز

 تیرمهاي ها نموآز

 سنجش عاطفیي ها نموآز

 ازمون هاي شناختی
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 بر لالتد د،شو می هپرسید دشا برنامه در زانموآ نشدا از زشموآ نپایا در که هایی السؤ

 دارد؟ شیابیارز عنوامکد

ین زغاآ

تکوینی 

 تشخیصی

 رکمیت
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 هپرسید دشا برنامه در زانموآ نشدا از زشموآ حین در که هایی السؤ

 دارد؟ شیابیارز عنو امکد بر لالتد د،میشو

ین زغاآ

تکوینی 

 تشخیصی

 کمیاتر
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ،جستجو يهارموتو ،بررکا ايبر عمومی يبررکا سطوا ارد،ستاندا يها کلیک و يبرونا سیستم

 ؟ندرو می ربکا نیکیولکترا يگیردیا یژگیو امکد دیجاا ايبر ها برلینکا و گرهاورمر

 يگیردیا

 نه راهمکا

  دبررکا سهولت

 تعاملی بودن

 تخصص ندگانگیچ
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 ؟ستا همشاهد قابل نیکسا چه توسط بررکا موبایل رهشما

 همه

 من مخاطبین کس هیچ
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 بررکا دخو رختیاا در موبایل رهشما نمایش تعیین

 ستا

 
 

 ايبر امحتو تألیف يها برنامه و هاورسر ،گرهاورمر ،ها برلینکا ،ینترنتا اربزا زش،موآ حیاطر

 ؟ندرو می ربکا نیکیولکترا يگیردیا یژگیو امکددیجاا

 

نه راهمکا يگیردیا

 دبررکا سهولت

 دنبو تعاملی

 تخصص چندگانگی
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 .ستا                      ستیابی بهاي دمشخص بري شی تهیه برنامههازموآحی اطر
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ريفتار افهدا

 شناختی افهدا

 نگرشی افهدا

 شیزموآ افهدا

 

 ؟ستا پذیر نمکاا طریق امکد به درس سکلا وهگر در زانموآ نشدا عضویت

 

 طریق از وهطریق لینک گر از

 ازبیر د توسط عضو ودنفزا

 دشا عضویت سیستم طریق

 اردمو همه
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 ؟کند می زموآ نشدا به کمکی چه دشا در اريگذربا مهنگا فایل یک به دادن انعنو

 

 فایل ايمحتو و عموضو از گاهیا

 

 رتصو در انعنو تغییر معدع موضو و مطلب حتتررا يجستجو

 دمجد يها اريگذربا مهنگا منا ییرتغ

 اردمو همه
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 ؟کند می زموآ نشدا به کمکی چه دشا در اريگذربا مهنگا فایل یک به دادن انعنو

 

 فایل ايمحتو و عموضو از گاهیا

 

 در انعنو تغییر معدع موضو و مطلب حتتررا يجستجو
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 دمجد يها اريگذربا مهنگا منا تغییر رتصو

 اردمو همه

 ؟کند می زموآ نشدا به کمکی چه دشا در اريگذربا مهنگا فایل یک به دادن انعنو

 

 فایل ايمحتو و عموضو از گاهیا

 در انعنو تغییر معدع موضو و مطلب حتتررا يجستجو

 دمجد يها اريگذربا مهنگا منا تغییر رتصو

 اردهمه مو
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 هخیرذ پوشه امکد در ترتیب به یدئوییو و يتصویر ،متنی ،صوتی يها فایل

 د؟میشو

Shad Documents ،Shad Videos ،Shad Images ،Shad Audio 

 Shad Images، Shad Videos، Shad Documents،Shad Audio 

 Shad Videos،  Shad Images،  Shad Documents،Audio Shad 

Shad Audio ،Shad Videos  ،Shad Images  ،Shad Documents 
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 ؟شوند می هخیرذ کجا ز،سا شبیه در هشد دنلودا یدئوییو يها فایل

Download > Memo Download 
Desktop > Memo Download 

Video Videos> Memo 

Download > Memo Document 
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 .شدبا               ست یکاممکن زش موآیند آفرل طودر برنامه اي درون صددن بول فعا

 صوتییترازپا

 
 
 
 
 
 
 
 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

  تعامل عامل

 عامل توجه

 شیزموآعامل 
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 به طمربو ،باشد پذیر نمکاا مختلف قطر به برنامه یا نفرما یک ايجرا قابلیت

 ؟ستا يبررکا بطرا حیاطر یژگیو امکد

 ترتیبو  نظم

 يپذیرفنعطاا

 رختصاا

 

 ريگازسا
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؟معناست چه به رساختیز يیزر برنامه در بالا تحمل قابلیت

 یرساختآوري ز بتا

 قابلیت افزایش تعدادکاربران

 اتتغییر مقابل در يپذیر فنعطاا

 باندي یش پهناافزا ابلیتق
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟معناست چه به یرساختز يیزر برنامه در سترسید قابلیت

 دباش سسترد در نیکیولکترا يگیردیا يها برنامه هفته روز هفت در ساعت 24 یعنی

 باشد سسترد در نیکیولکترا يگیردیا يها برنامه هفته لطو در روز در ساعت 8 قلاحد یعنی 

 نمکا هر در سترسید قابلیت یعنی
 

 دفر هر ايبر سترسید قابلیت یعنی
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 وهگر به رهبادو ننداتو می چگونه ،ندا هشد فحذ وهگر از که هسیا لیست در دموجو انبررکا

 ؟نددبرگر

 

 مدیرتعودا ب فقط

 طریق لینکاز  فقط

 .نددبرگر ننداتو نمی رهبادو رهشما ینا با

 شوند هویت ازحرا و نمایند نصب و فحذ را دشا باید رهبادو
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 .می کنندد یجاا                      طتباارقع یک در واها ل کانا

 تعاملی 

 سویه یک

 سویهدو

 دهگستر
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟باشد باید یرز ردمو امکد د،شا برنامه طریق از زشموآ یندآفر در تتوجها نکانو

 

 زشموآصلیا عنصر انعنو به شیزموآ حیاطر به توجه

ل محصو یک انعنو به نیکیولکترا ايمحتو تولید به توجه

 ردخوزبا یافتدر ايبر شیابیارز به توجه

 هاارفزا منر و ها ارفزا سخت به توجه
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 ؟ستا سهرمد یک زانموآ شندا ختصاصیا امکد
 

120 

 

ورش پر و زشموآ لکانا

 یشزومآ داوم و اوتحم لکانا

 سهرمد لکانا
 

 نمعلما لکانا

 

 ؟ستا سهرمد یک نمعلما ختصاصیا امکد

 

ورش پر و زشموآ لکانا

 ادمو و امحتو لکانا

 شیزموآ

 سهرمد لکانا

 

 نمعلما لکانا
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ارد؟ند وهگر به هشد ضافها هوگر مدیر را یرز راتختیاا امکد

 مدیر ودنفزا بررکا فحذ

 وهگر فحذ

 عضاا سترسید تغییر

 
 
 
 
 
 
 
 

122 

 دارد؟ دجوو دشا در نمکاا امکد

یگر د دفر توسط وهگر به دفر ودنفزا

یگر د دفر توسط لکانا به دفر ودنفزا

 یگرد دفر توسط دشا به دفر ودنفزا

 ستا صحیح ب و لفا
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 ارد؟ند دجوو دشا يها فایل هخیرذ پوشه در پوشه امکد

یر وتصا پوشه

یدئوها و پوشه

 نیمیشنا پوشه

 متنی يها فایل پوشه
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 ؟کند می نبیا را مینهز حالت بهترین جمله امکد

باشد  نوشته نگر به یکدنز مینهز نگر

باشد  متن نگر با دتضا در مینهز نگر

125  
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 باشد تصویر یک مینهز نگر

 دشو بنتخاا رنو انمیز با متناسب مینهز نگر

؟ نیست صحیح دشا يستیکرهاا ردمو در جمله امکد

 اردند دجوو دشا در ستیکرا از دهستفاا نمکاا

 دارد دجوو دشا در ستیکراز ا دهستفاا نمکاا

 دارد دجوو دشا در ستیکرهاا هیوگر زيسا لفعا نمکاا

 

 دارد دجوو دشا در ستیکرا ودنفزا نمکاا

126  
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 ؟ستا صحیح دشا برنامه ردمو در جمله امکد

 اردند دجوو حاضر لحا در مدیر و بیرد توسط وهگر و لکانا دیجاا نمکاا 

 دارد دجوو حاضر لحا در مدیر و بیرد توسط وهگر و لکانا دیجاا نمکاا

 ستا پذیر نکاما مدیر ايبر لیو اردند دجوو حاضر لحا در بیرد توسط وهگر دیجاا نمکاا
 

 نمکاا بیرد ايبر لیو اردند دجوو حاضر لحا در مدیر توسط لکانا دیجاا نمکاا

 ستا پذیر

128  
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 ؟ستا تر صحیح رکادخو دنلودا ردمو در جمله امکد

 باشد بسته ینترنتا حجم فمصر در جویی صرفه جهت رکادخو دنلودا ستا بهتر 
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 نباشد ستید دنلودا به زنیا تا باشد زبا رکادخو دنلودا ستا بهتر 

 باشد زبا خصوصی يگفتگوها رکادخو دنلودا
 

 اردند مصرفی بسته حجم و سرعت در نیاچند تأثیر رکادخو دنلودا

8 

 
 ؟ستا ستدر جمله امکد

 

 ستا مخاطب دنکر ودمسد نهما وهگر از فحذ

 129  
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 ستا یخچهرتا دنکر كپا مثل مخاطب دنکر ودمسد

 ستا وتمتفا مخاطب دنکر ودمسد با وهگر از فحذ

 ماند می باقی مخاطب یخچهرتا وهگر از فحذ در

 

  

 

 

 

 

 ؟نیست صحیح جمله امکد

 را تتعاملا سرعت ها مپیا نمایش پیش دنبو شنروکند  می کمک قعیوا نماز در تتعاملا شگستر به ها مپیا نمایش پیش دنبو شنرو

 کند می بیشتر

 دشو پرتی اسحو موجب ستا ممکن یسرتد نماز در نمایش پیش دنبو شنرو
 

 میکند بیشتر را تتعاملا مانیز فاصله ها مپیا نمایش پیش دنبو شنرو
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟نیست صحیح جمله امکد

 دارد  دجوو فلاینآ رتصو به دشا از دهستفاا نمکاا

 کند می مشخص فایلوپر منا رکنا در نلاینآ کلمه با را نلاینآ ادفرا دشا

 دشو دستفاا نلاینآ رتصو به باید دشا از

 

 ستا تشخیص قابل دشا در ادفرا دنبو فلاینآ یا نلاینآ
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 می کنیده ستفاز اشبیه سااز مانی که ز ارد؟ند نصب به زنیا دشا برنامه از دهستفاا حالت امکد

کنید  می دهستفاا اههمر گوشی از که مانیزد 

 کنید می دهستفاا نکلو از که مانیز

 کنید می دهستفاا وب تحت نسخه از که مانیز
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 مستقیم طتباار عناصر سایر با نیکیولکترا يگیردیا هشوند ارتکر یندآفر دارنمو در عنصر امکد

 دارد؟

 

 حیاطر

تولید 

ي گیردیا

 یابیارز
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 ؟ستا زمجا دشا در يبررکا منا ايبر کترراکا امکد

 خط یرز

 نقطه 

 هتیر خط
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 نقطه دو

  

 ؟هدد می ننشا ستدر راp 3 رپیوستا گزینه امکد

People > Process > Publish 

People > Program> Product 

People > Project > Product 

People > Process > Product 
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 ؟ستا ستدر گزینه امکد

 .ستا تنظیم قابل زسا بیهش برنامه در ،یدروندا و وزیندو در ،فایل عنو یک هخیرذ محل

 .ستا تنظیم قابل زسا شبیه برنامه در وز،یندو در ،فایل عنو رچها هخیرذ محل

 .نیست تنظیم قابل زسا شبیه برنامه در ،یدروندا و وزیندو ايبر ،فایل عنو رچها هخیرذ محل

 .ستا تنظیم قابل زسا شبیه برنامه در ،یدروندا و وزیندو در ،فایل عنو رچها هخیرذ محل
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 ؟هدد می ننشا ستدر را MEmuدر دشا يها فایل پوشه به سترسید گزینه امکد

Tools> Downloads> Shad 
Shad Tools> File Manager> 

Tools> File Manager> Download 

Tools> Shad> File Manager 
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 لساار که متنی رکنا در که یمانز با یددکر یافتدر که متنی رکنا در که مانیز گزینه امکد

 ؟ستا وتمتفا ،کنید می کلیکیددکر

 

پاسخ 

 لساار

 دنکر قسنجا
 

 یشایرو
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ارد؟ند را رختیاا ینا مدیر و هست سکلا معلم رختیاا در فقط یرز گزینه امکد

 حذف گروه 

 وهگر يعضاا به سترسید

 هسیا لیست به سترسید

 وهگر تطلاعاا به سترسید
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 ارد؟ند را رختیاا ینا مدیر و هست سکلا معلم رختیاا در فقط یرز گزینه امکد

 

 هسیا لیست به سترسید

 وهگر يعضاا به سترسید

 مالکیت لنتقاا

 

 وهگر تطلاعاا به سترسید
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 ؟میدهد ننشا ستدر را فایل هخیرذ ايبر دشا پوشه تمحتویا گزینه امکد

 

Shad Videos ،Shad Images ،Shad Documents 

Shad Videos ،Shad Text ،Shad Documents ،Shad Audio 

Shad Videos ،Shad Documents ،Shad Audio 

 Shad Videos،  Shad Images،  Shad Documents،Audio Shad 
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؟ هدد می ننشا ستدر را دشا برنامه در سانهر رکادخو دنلودا بستن محل گزینه امکد

دن کر زبا< ها سانهر رکادخو دنلودا< زيسا هخیرذ و ها داده< تماتنظی

 دنکر زبا< ها سانهر رکادخو دنلودا< هادنلودا< تتنظیما
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 بستن< ها سانهر رکادخو دنلودا< زيسا هخیرذ و ها داده< تتنظیما

 بستن< ها سانهر رکادخو دنلودا< هادنلودا< تتنظیما

 ؟ستا نیکیولکترا يگیردیا »يزچی چه« بیانگر ردمو امکد

 

 .دگیر می رتصو یجیتالید يهااربزا طریق از که يگیردیا و زشموآ

 افهدا به تا کنند کمک نگیرندگادیا به که ستا ینا نیکیولکترا يگیردیا يها دوره فهد

 یا( نمازسا صلیا افهدا که هندد منجاا هایی روش به را دخو تکالیف یا برسند ديفري گیردیا

 .بخشنددبهبو را )جامعه

 .بگیرند دیا را آن تا کند می کمک ادفرا به که ستا شیزموآ ايمحتو شامل

 ،نیمیشنا ،یروتصا ن،متو ر،گفتا مثل اي سانهر عناصر از که یجیتالید يهااربزا طریق از زشموآ

 دمی گیررت صو ... ویدئوو
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 ؟ستا دشا در منیتیا مسائل به توجه بیانگر ردمو امکد

 هویت ازحرا

 کد لساار

 منیتیا

 اي مرحله دو واژه رگذ از دهستفاا

 ردسه مو هر
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟ستا نیکیولکترا يگیردیا ییاچر بیانگر ردمو امکد

  .درگی یم ترصو یلایتجید يهارازبا قیرط زا هک يریگدای و شزومآ

 افهدا به تا کنند کمک نگیرندگادیا به که ستا ینا نیکیولکترا يگیردیا يها دوره فهد

 (نمازسا صلیا افهدا که هندد منجاا هایی روش به را دخو تکالیف یا برسند ديفري گیردیا

 .دنشخب دوببهرا) جامعه یا

 .درنیگب دای ار نآ ات دکن یم ککم دارفا هب هک تسا شیزومآ ياوتحم ملشا

 ،نیمیشنا ،یروتصا ن،متو ر،گفتا مثل اي سانهر عناصر از که یجیتالید يهااربزا طریق از زشموآ

 دگیر می رتصو و یدئوو
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 ،نیمیشنا ،یروتصا ن،متو ر،گفتا مثل اي سانهر عناصر از که یجیتالید يهااربزا طریق از زشموآ
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 می رتصوو یدئوو

 دگیر

 
 

 ؟ستا نیکیولکترا يگیردیا چیستی بیانگر ردمو امکد

 يها دوره فهد .دریگ یم تروص یلایتجید يهارازبا قیرط زا هک يریگدای و شزومآ

 يگیردیا افهدا به تا کنند کمک نگیرندگادیا به که ستا ینا نیکیولکترا يگیردیا
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟نیست دشا برنامه يبررکا بطرا صلیا يها بخش جز ردمو امکد

 

 نسار مپیات تنظیما

 رواژهگذ

 مخاطبین
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 ؟نیست نیکیولکترا يگیردیا صلیا بچورچا ءجز ردمو امکد

 

 حیاطر

مسائل  شیزموآ

 مسائلوري فنا

 شگاهیزموآ

 امحتو حجم
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 ؟نیست نیکیولکترا يگیردیا صلیا بچورچا ءجز ردمو امکد

 

 مدیریت پشتبانی

 مسائلمنابع 

 خلاقیا

 ها لینک برا
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 ؟نیست نیکیوترلکا يگیردیا صلیا بچورچا ءجز ردمو امکد

 

 نموآز يها السؤ عنو

 

 شیابیارز
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 
 خلاقیامسائل 

 يبرربط کارا حیاطر

 

 
 

 ؟نیست نیکیولکترا يگیردیا صلیا بچورچا ءجز ردمو امکد

 

 حیاطر

مسائل  شیزموآ

 مسائلوري فنا

 شگاهیزموآ

 امحتو حجم
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 ؟نیست نیکیولکترا يگیردیا در ريوفنا به طمربو مسائل صلیا بخش سه ءجز ردمو امکد

 

 یرساختي زیزر برنامه

 

 ارفزا سخت

 ارفزامنر

 ینترنتا
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 باشد گرا ماا نیست نیکیولکترا يگیردیا در ها مسئولیت و ها نقش مهمترین ءجز ردمو امکد

 ؟شد هداخو بهتر لمحصوکیفیت

 ییامحتو یا موضوعی متخصص 

 شیزموآ احطر و یستژتکنولو 

 امعلمی رسمد
 

 یشگرایرو
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟ستا هنشد نبیا ستدر نیکیولکترا يگیردیا ماهیت رهبادر ردمو امکد

 

  .دگیر می رتصو معلم طریق از زشموآ :چیستی

 به تا کنند کمک نگیرندگادیا به که ستا ینا نیکیولکترا يگیردیا يها دوره فهد :ییاچر

 صلیا افهدا که هندد منجاا هایی روش به را دخو تکالیف یا برسند ديفر يگیردیاافهدا

 .بخشند دبهبو را)جامعه یا( نمازسا

 .بگیرند دیا را امحتو تا کند می کمک ادفرا به که ستا شیزموآ ايمحتو شامل :يچیز چه
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 ،یروتصا ن،متو ر،گفتا مثل اي سانهر عناصر از که یجیتالید يهااربزا طریق از زشموآ :چگونگی

 .دگیر می رتصو ... و یدئوو ،شننیمیا

 

 ؟ستا هنشد نبیا ستدر نیکیولکترا يگیردیا ماهیت رهبادر ردمو امکد

 

  .دگیر می رتصو معلم طریق از زشموآ :چیستی

 به تا کنند کمک نگیرندگادیا به که ستا ینا نیکیولکترا يگیردیا يها دوره فهد :ییاچر

 صلیا افهدا که هندد منجاا هایی روش به را دخو تکالیف یا برسند ديفر يگیردیاافهدا

 .بخشند دبهبو را)جامعه یا( نمازسا

 .بگیرند دیا را امحتو تا کند می کمک ادفرا به که ستا شیزموآ ايمحتو شامل :يچیز چه

 ،یروتصا ن،متو ر،گفتا مثل اي سانهر عناصر از که یجیتالید يهااربزا طریق از زشموآ :چگونگی

 .دگیر می رتصو ... و یدئوو ،نیمیشنا
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 ؟ستا رجخا وهگر يعضاا سترسید و راتختیاا از یرز ردمو امکد

 

عضو  ودنفزا

 مدیرودن فزا

 عضاالیست  نیدد

 انمدیر لیست نیدد
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 ؟نیست دشا تخصصی ارفزا منر يیاامز از یرز ردمو امکد

 دنبو تعاملیدن بو ملی و بومی

 نشتدانتقالی ا دیکررو

  
 
 
 
 
 
 
 

158  
 زشموآ ايبر دنبو ديبررکا

 تلفیقیيها

 ؟ستا دهکر حمطر ستدر را حیاطر تیم لمحصو ردمو امکد

 ارفزا منر حیاطر

 

 )شیزموآ حیاطر( درس حطر

 انگیرافر يگیردیا
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 وژهبرنامه پر
 

 هدرک حرطم تسرد ار يرادهگن میت لصوحم درمو ماکد

  ؟تسا

  رتنظاو سانیر وزبر ،منیتا ،سیدر ادمو هخیرذ
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 هشد حصلاا )سیدر ايمحتو( يگیردیا ادمو هخیرذ

 وژهپر برنامه ئهارا
 

 يگیردیا ادمو ئهارا

 منر محیط حیاطر در ثابت ندرو یک دجوو به يبررکا بطرا حیاطر به طمربو ردمو امکد

 ؟کند می رهشاا آن ايجراو اريفزا

 

 ترتیبو  نظم

 يتفکیکپذیر

 تباث
 

 گیدسا
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 ؟کند می حمطر را نیکیولکترا يگیردیا یژگیو ردمو امکد

 

 متمرکزدن بو تعاملی

 دنبو گیرافر بر

 نمکا هر و نماز هر در يگیردیا

 

 اردمو همه
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 ؟کند می حمطر را نیکیولکترا يگیردیا یژگیو ردمو امکد

 

 متمرکزدن بو تعاملی

 دنبو گیرافر بر

 نمکا هر و نماز هر در يرگیدیا
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 

 اردمو همه

 یدروندا زسا شبیه یا زيمجا ماشین یک یرز ارفزا منر امکد

 ؟ستا
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 Adobe Connect  

sky room 

MEmu 

Captivate 

 

 ارد؟ند را دشا برنامه به ورود نمکاا حاضر لحا در نقش امکد

 

 سهرمدمدیر

 سهرمد ونمعا

 معلم
 

 زموآ نشدا
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 دارد؟ چندگانه نقش یک ،نیکیولکترا يگیردیا در نقش امکد

 نشناسارکا

 یستژتکنولو کامپیوتر

 شیزموآ

 مدیر

 

 معلم
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 ؟کند می وادار تفکر به بیشتر را زانموآ نشدا یرز يها السؤ از عنو امکد

 

 اهمگر يها السؤ
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 اگري واهاالسؤ

 پاسخ بسته يها السو

 یحیتشري ها السؤ

167 

 ؟نمی باشدي برربط کاراحی ابه طرط یژگی مربوام وکد

 

 دنفهم بو قابل

 

 گیدگستر

 ح ضوو و گیدسا

 ردخوزباو هنما را داراي
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 باید زيمجا زشموآ در که ستا خلاقیا مسائل ءجز یرز اردمو از یک امکد

 د؟شو عایتر

فرهنگی  گوناگونی به توجه

ها  يگیر جهت و تتعصبا از دوري

 قانونی تموضوعا گرفتن نظر در

 اردهمه مو
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 د؟شو عایتر باید زيمجا زشموآ در که ستا خلاقیا مسائل ءجز یرز اردمو از یک امکد

 دوريفرهنگی  گوناگونی به توجه

 نظر درها  يگیر جهت و تتعصبا از

 قانونی تموضوعا گرفتن

 اردمو همه
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟نیست نیکیولکترا يگیردیا در نلاینآ منابع شامل یرز اردمو از یک امکد

 

 لغت فرهنگ و ها اي سانهرچند شیوآر

نیکی ولکتري اها بکتا

 نلاینآ متخصصین

 تمجلاو  کتب
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 .ستا                       بام ورود مستلزد برنامه شات تنظیمادر  »وجخر«روي کلیک 

رواژه گذ

پین کد 

 پیامکی کد

 اي مرحله دو ژهرواگذ
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 ؟ستا دشا پلیکیشنا در گزینه امکد دلمعا وب تحت دشا در من رهبادر گزینه

 

 يبررکا منا

 

 منا
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 فایلوپر

 

 فیابیوگر تنظیم

 

 ؟ستا مپیا امکد تمکاناا از یشایرو گزینه

 

 یصوتمپیا

 متنیم پیا
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 يتصویر مپیا 

 ها فیلم و ها فایل

 د؟شو می ساخته کسی چه توسط سهرمد لکانا ینکل

 دبرنامه شا نندگازسا

 مدیر

 نینومعا

 دشا برنامه پشتیبانی
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 ؟هستند کسانی چه دشا برنامه در نیکیولکترا ايمحتو تولید ايبر ییامحتو یا موضوعی متخصص

 

ان مدیر

 نمعلما

 کامپیوتر نشناسارکا
 

 شیزموآ يها یستژتکنولو
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 ؟ستا رچقد دشا پلیکیشنا در سالیار يها فایل حجم یتودمحد

 

 مگابایت 30 کثراحد

 مگابایت 50 کثراحد

 مگابایت 70 کثراحد

 مگابایت 100 کثراحد
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 ؟ستا ساعت چند دشا برنامه در زانموآ نشدا با تعامل و یسرتد مانیز یتومحد
 
 

178  
 یتودمحد ونبد

 مانیز

 

 



وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

سه رمد هفتگی امهبرن طبق

 ر اداريساعت کال طو در

 روز در ساعت 8 کثراحد و 6 قلاحد

 

 مینهز در ،شگاهیزموآ مسائل به طمربو نیکیولکترا يگیردیا بچورچا سساا بر سهرمد مدیر

 ؟کند غفلت نباید ردمو امکد از انگیرافرتخدما

 

ا جرا صلاحیت تأییدیه

 جسمیان ناتو نگیرندگادیا

 ريکا ربا
 

 سلاک ازهندا
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 ؟هست کسانی چه رختیاا در سهرمد لکانا مدیریت

 

ان بیرد

مدیر 

 نینومعا

 زانموآ نشدا
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 ستا نیکیولکترا يگیردیا يیندهاآفر مختلف حلامر مدیریت ،نیکیولکترا يگیردیا مدیریت

 :شاملکه

 .دوش یم يرادهنگ و هئارا ،یبایزرا ،یحارط ،دیلتو ،يزیر همانبر

 .دشو می یابیارز و ارينگهد ،ئهارا ،تولید ، حیاطر ي،یزر نامهبر

 .دشو یم يرادهگن و هئارا ،یابیزار ،دلیتو ، یحارط ،يزیر همانبر

 .دشو می ئهارا و ارينگهد ،یابیارز ،تولید ، حیاطر ي،یزر برنامه
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

  ...ینیع يریگدای يزاس رادانمع

 انشآ میفاهم اب دیدج یمفاهم نداد طبر

مفاهیم دن کر معنی

 طتباارجدید 

 دروس ییامحتو

 يگیردیا تعمیق
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 ؟چیست شیزموآ پیش يهادهبررا در امحتو به ازنداچشم از رمنظو

 

 برنامهز غاآ در افهدا به کلی هنگا

برنامه  زغاآ در امحتو کل به کلی هنگا

 زشموآ يپیامدها به توجه

 شیابیارز يها هشیو به توجه
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 :از ستا رتعبا شیزموآ يها سرگرمی و زيبا یژگیو مهمترین

ا در جراگیر قابلیت افر سن با تناسب

 اول متدي هاارفزاسخت 

 سیدر ايمحتو و افهدا با دنبو متناسب

 دنبوروز  به
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

 ؟ستا امکد دشا برنامه طریق از زشموآ در ديبررکا يهاارفزا سخت یژگیو مهمترین

 

 باشد روز به کاملاً

 باشد انبررکا زنیا يپاسخگو 

 باشد شتهدا مناسب قیمت

 باشد وريفنا نسناسارکا تأیید ردمو

185  
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 ؟چیست اگروا يها السؤ یژگیو مهمترین

 

 تفکر به مخاطب شتنوادا

 نظر رظهاا به مخاطب شتنوادا

 تر قیقد شیابیارز
 

 ها پاسخ دنبو بر نماز

  
 
 
 
 
 
 
 

1
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 .ستا                                توسعهاي مناسبی برار بزد اتخصصی شاار فزا منر

 رسیا يگیردیا

  
 
 
 
 

1
8
7 

 
 يگیردیا

 نتقالیا

 
 

 

 کتیرمشا يگیردیا

 

 هیوگر يگیردیا
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 .ستا                                توسعهاي مناسبی برار بزد اتخصصی شاار فزم انر

 رسیا يگیردیا

  يیرگدیا

 يگیردیانتقالی ا

 کتیرمشا

 هیوگر يگیردیا
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 ؟هست سترسید قابل یرز سایت امکد در دشا وب تحت نسخه

 https://sanadweb.iranlms.ir

 irhttps://hamgamweb.iranlms.

https://meduweb.iranlms.ir 

https://shadweb.iranlms.ir 
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 ؟چیست لکانا و وهگر در مپیا دنکر قسنجا از فهد

 مپیا به مخاطب توجه جلب

 لساار مپیا تفکیک

مخاطب  به مپیا

 مپیادن کر لینک
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 .هستزي مجازش مودر آ                                یکد یجاد اصلی برنامه شاف اهد

 يگیردیا مدیریت سیستم

شبکه  نسار مپیا

 شبکهجتماعی ا

 سانیر عطلاا
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https://sanadweb.iranlms.ir/
https://hamgamweb.iranlms.ir/
https://meduweb.iranlms.ir/
https://shadweb.iranlms.ir/
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 ،شیزموآ يهافهد انعنو به یشهااگر و هارتمها ،نشهادا از سلسله یک به ستیابید ايبر ههرگا

، در تنظیم شوندو پیش بینی زش موآتحقق از شی پیش زموي آهاو روشفعالیتها از  ايمجموعه

 رتصو گرفته ستاقعوا

 درس حطر

رت حی مهااطر 

 شیزومآ یحاطر

 ...................... سیدر برنامه
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 ریاس زنی و لایتجید فلتخم ياه يروانف ياه یگژیو و عبامن زا هدفاتسا اب یکینورتکلا يرگیدیا

 .هم می کندافر،  ....................  و         يگیردیک محیط یاي، گیردیاي هااربزالاکـشا

 هشد یعزتو و زبا ادينفرو ا هیوگر

 ینترنتو ابر کامپیوتر  مبتنی
 

 رينحصاا و پذیر فنعطاا
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 .دبنا می شو                 یر ساختزنیکی بر یک ولکتري اگیردیک محیط یا

 اینترنتی
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
 

 

یی امحتو

 لیجیتاد

 جتماعیا

  

 ؟چیست هادنلودا پوشه در فایل هخیرذ و دنلودا هعمد مزیت یک

 فرمت تغییر

کیفیت  یشافزا

 حجم کاهش

 فایلم نا حفظ
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 ؟چیست دشا يها پوشه در فایل هخیرذ و دنلودا هعمد مشکل یک

 فایلم نا یرتغی

 کیفیت تغییر

 حجم تغییر

 

 فرمت تغییر
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 ...که ستا ینا کلاسی يها وهگر در زانموآ نشدا عضویت يها راه ترین دهسا از یکی

کند  وهگر عضو را زانموآ نشدا تک تک بیرد

ارد بگذاك شترایگر به س دکلاس در کلا لینک

 کند وهگر عضو را زانموآ نشدا تک تک مدیر

 اردبگذاك شتراسه به رمدل کاناوه را در رگ لینک
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وه ضمن خدمت وتعامل فرهنگیان ابرگر    
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